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Mizu VoIP Server is a Class4/5 softswitch application for the Microsoft Windows platforms. 
Modules: SIP stack, H323 gateway/gatekeeper, SIP-H323 protocol converter, access roles, routing (rule based, BRS or LCR), 
failowering, load balancing, quality routing, e-payment, billing, accounting, CDR records, blacklist/whitelist filtering, callcenter, IVR, 
HTTP service, call recording, conferencing, media server, alerting, statistics generation, watchdog, enduser web portal, client 
applications and others. 
 

Install 

Requirements 
The Mizu VoIP server is a robust native application written in pure C++ with a big throughput that can scale well from old Pentium3 (testing or home usage) up to 

modern SMP systems with 32 processors (enterprise VoIP service providers) 

 OS: Windows Server 2003 or 2008 (Windows XP for home usage or testing) 
 Database: MS SQL Express 2005 or 2008 for less than 1000 simultaneous calls (included in the install package),  

full MSSQL (2000, 2005 or 2008) for more calls.  
 CPU: single core PIII for home, testing or small business usage, dual core cpu for less than 500 parallel call, quad core or 

more for more than 1000 parallel call 
 RAM: minimum 500 MB RAM,1 GB RAM for less than 400 simultaneous calls, 4 GB RAM for more than 1000 simultaneous 

calls 
 Disk: 128 GB HDD without voice recording and callcenter, 512 GB HDD for high load or if you have a long list of callcenter 

clients or need to use voice recording. Additional disks for big database load (for example one for temp database, another for the mserver 

database and a third disk for the VoIP application server) 

 Network: ~1 MB for 200 parallel calls without RTP routing or 20 calls with routed RTP. Public static IP is preferable. You 
might also need a sub-domain (e.g. sip.yourcompany.com) for easier client software configuration.  

 
Typical recommended configuration for VoIP service providers: 2 server with quad core cpu, 4 GB RAM, 3x128 GB HDD. By using 2 servers you can separate the 
application server from the database server and also you will have a hot backup. 

 

Install process: 
 Follow the automated install procedures if you are not familiar with windows services and MS-SQL 
 Follow the manual install procedures in the following cases: 

o if you are familiar with MS-SQL and windows administration 
o if custom installation needed (for production servers) 
o if you already have MS-SQL installed on the local server or LAN 
o if the automatic install procedure fails 

Automated install 

1. Download the server install package from the MizuTech webpage: http://www.mizu-
voip.com/webinstaller/MizuVoIPServer.exe.  

2. Launch the install wizard and follow the instructions. 

Manual install 

1. Hosting server 
Prepare your server (set autoreboot on power failure, set /3GB or /PAE on 32bit systems with more than 4GB RAM, uninstall or disable any 

unneeded service. No need for virus scanner on production servers!) Check the requirements above. For a test install any Windows PC is ok 

http://www.mizu-voip.com/Products/VoIPServer.aspx
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(2000,XP,Vista,Win7,Server 2003,2008). For production we recommend windows server 2003 or 2008. Mizutech can also offer VoIP hosting. This is 
convenient especially for smaller installations (below 500 simultaneous calls) to save on your hosting fee. 

2. Mizu-VoIP application server 
Download and install required software from  
http://www.mizu-voip.com/webinstaller/MizuVoIPServerNoSQL.exe 
By executing the install package, all files are extracted in the install directory that you have specified.  
Mizu Server doesn’t copy anything in your system directory. 
The main executable (mserver.exe by default) is registered as a windows service (mserver.exe /install) 

3. MS-SQL 
Install MS-SQL 2000, 2005 or 2008 if not already installed. Free download from here. 
You might choose a package that contains also the Management Studio tool for easy administration. 
While installing choose “Mixed mode SQL authentification”! 
TCP/IP access needs to be allowed. Use the “SQL Server Configuration Manager” tools shipped with the MS-SQL install 
package. Enable TCP/IP (enable separately for all interface that you might wish to use) and set the ports to 1433. You might 
change the default MS-SQL listen port to 2223 to filter out the most of the unauthorized login attempts. 
Make sure that the service startup type is set to automatic. 

4. Firewall configuration 
If you are using a local firewall, enable the followings: 
-MS-SQL main executable: C:\Program Files\Microsoft SQL Server\MSSQL10.MSSQLSERVER\MSSQL\Binn\sqlservr.exe 
-VoIP application server: C:\Program Files\MizuVoIPServer\mserver.exe 

-Web portal template (optional): C:\Program Files\MizuVoIPServer\MizuWebService.exe 

-H323 server (optional): C:\Program Files\MizuVoIPServer\atarongk.exe 

-SIP-H.323 converter (optional): C:\Program Files\MizuVoIPServer\vsip.exe 

-Voice recording (optional): C:\Program Files\MizuVoIPServer\mserverftp.exe 

 

5. Database 
Create a database in your SQL engine. You can use the “mserver” as its name but otherwise you can name it after your 
choice.  Restore its content from dbtemplate.dbt (for example using the SQL Management Studio tool)  
To create the initial database you can also use the MDBSetup.exe application or you can create the initial database by 
running the scripts from mserverscript.sql. 

6. VoIP service 
Edit the [database] section in mizuserver.ini configuration file (in the program directory near mserver.exe). Add the newly 
created database access here (ip, port, database name, username, password) 
Example: 

[database] 
location=127.0.0.1 
port=1433 (or 2223) 
name=mserver 
username=sa 
password= srEgtknj34f 

Start the Mizu VoIP service (start.bat or from Services) 
Check the log file if any startup error exists. (Open the last “log_xxx.dat” files near the mserver.exe with notepad or 
TotalCommander F3 or using the logviewer application from the Tools directory if you have installed it).  Search for 
“CRITICAL”, “ERROR”, “catch” and “WARNIG” messages. 
 

Notes and troubleshooting 

 You will need administrator rights for the install process 
 Make sure that the mserver.exe is allowed by your firewall. Also enable the mssql executable if you wish to use the admin client 

(MizuManage) remotely 
 .NET framework is needed for MS-SQL 
 You might have to enable App server roles (which will install .NET) if you are using Windows Server 2008 
 The service user (login as) needs full read and write access to the program files directory 
 The automated install process will install an MS-SQL Express 2008 SP1 32 bit edition named MSSQL$MIZU 

http://www.mizu-voip.com/webinstaller/MizuVoIPServerNoSQL.exe
http://www.microsoft.com/express/sql/download/


The default username for MS-SQL is “sa” and the default password is “srEgtknj34f”. You can change the sa password anytime later. 
 For a production server it is recommended to setup a dedicated user with fine-tuned access rights instead of using the sa account. 

 If the installer fails then you might have to install the MS-SQL yourself then run the installer again 

 If the installer cannot install the ms-sql server automatically, then you can download and install it from 
http://www.microsoft.com/express/sql/download/ 

 The main VoIP service executable file is “mserver.exe”. This can be also installed manually with the /install command line switch and 

started/stopped using windows services management or the start.bat and stop.bat files. 

 Make sure that the VoIP service and the sql service startup type is set to automatic (otherwise they will not start automatically on 

server restart) 

 If you get “object missing” or similar errors when you first open the MizuManage, make sure that the database structure was created 

successfully during setup. For this install the SQL management studio and check if you have tables under the mserver database. If not, 

then create the database if missing then open and run the mserverscript.sql file on the mizu database. This will create all tables and 

stored procedures needed. After this step you will have to run the Configuration wizard again (Mizu manage -> Tools menu -> Server 

setup)  

 Make sure that the sql service and the mserver service is running before to make any test calls 

 Check the log files if you have issues with the test calls (last *log.dat file) 
 All files required for the mizu voip server is also available from the ftp://mizu@mizu-voip.com/mizuvoipserverfiles 

 The NOD32 antivirus can trigger a false alert on some files. This is because the exe compression used. Set a rule to ignore the 

application directory. 

 Contact the Mizutech support with a remote desktop access if you have any further issue with the installation and configuration. 
Use only the built-in remote desktop and not any third party tool like VNC or TeamViewer. 

Configuration 

MizuManage 
Install and start the admin client software on the server or to any PC. It is part of the server install package or a separate 
install can be found at http://www.mizu-voip.com/Portals/0/Files/MizuManagement_Setup.exe 
Login to MizuManage: 

¶ App server: ip address of the server (database port followed after a comma if not using the default port) 

¶ DB server: type “default” if you are running the sql server on the same server with the VoIP application server. Otherwise the IP 
address of the database server (database port followed after a comma if not using the default port) 

¶ DB: database name (“mserver” by default) 

¶ Username: database username (“sa” by default) 

¶ Password: database password (“srEgtknj34f” by default) 
Example: 
 App server: myserver (127.0.0.1,1433) 
 DB server: default 
 DB: mserver 
 Username: sa 
 Password: srEgtknj34f 

Basic Settings 
Launch Tools -> Server setup -> Configuration wizard if not already started. Don’t change any setting that you don’t fully understand 
(leave default values) and click on Finish. 
After you have finished with the configuration wizard you might have to continue with the following tasks: 
- add your outbound routes and traffic senders:  Access -> Users and devices -> Sip Proxy and Traffic Senders 
- add your outbound routes and traffic senders:  Access -> Users and devices -> Sip Proxy and Traffic Senders, Routing 
- add users:  Access -> Users and devices -> Power User, Enduser 
- fine-tune other settings: billing, blacklists, etc 

 

Common Tasks 
All administration and monitoring tasks can be done from the MizuManage remote administration client.  

Nearly all operation will be influenced by the following filters: 

http://www.microsoft.com/express/sql/download/
ftp://mizu@mizu-voip.com/mizuvoipserverfiles
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 Quick filter: found in the top-left side in MizuManage. For example type “44*” in the quick filter box then open the “CDR 

Records” form and click “Load”. You should be able to see all calls to 44….. numbers. Or enter “test” and open the “Users 

and devices” form. Click on the load button to see accounts containing the “test”  word (in name, username, address, etc) 

 Direction filtering: accessible by double clicking on the space above the quick filter or from the Settings menu -> Set 

direction. When you are doing operation which needs more precision (eg. billing), always use the Set Directions form and 

not the quick filter. 

 Date-Time filter: found in the top-left side in the MizuManage. Useful to restrict statistics, reports and CDR listing intervals. 

Basic configuration 

For the basic server configuration you should walk through the configuration wizard accessible from the Tools menu -> Server 
setup. 
For more advanced options you will have to change global config options manually on the “Configurations” form. (Under “Other”) 

Creating users 

Users can represent real people, devices or virtual endpoints. 
You can easily create new users in the MizuManage application by cloning existing ones with the same type. 
For this, launch the “Users and Devices” form, select a user type, and click on the “Load” button. Then select any user entry and 
click on the “New User” button. You will be asked if you would like to create a new default user record or just clone the currently 
selected user. Usually you will select clone and just change the username, password, ip and authorization type for the new user. 
 
Endusers are the most commonly used type. It represents your customers. Usually you will select “Username/password” 
authorization for this type of users and enter a valid username and password. The username can be also used as a real phone 
number. Endusers can make voice or video calls between them usually for free of charge. IM and presence is also enabled by 
default. By default the server will route the RTP if needed (if users are behind NAT) or allow it to bypass your server saving your 
bandwidth. 
Traffic sender users are used for receiving traffic from other SIP servers and carriers. The authorization type is usually set to “Auth 
ip must match” and you have to enter a correct “Auth Ip” (or a list of ip address separated by comma). If you don’t have special 
requirements, the only thing that you have to communicate to your peers to be able to send calls to your server is only your IP 
address. (Your server needs a public IP for this or you have to setup proper port forwarding) 
For outbound traffic you need a SIP Server user. The most important parameter here is the “IP” where the VoIP calls will be sent. 
To be able to send and receive traffic to/from another SIP server or carrier you will have to add it as both a “traffic sender” and “sip 
server” user. 

Setup outbound routing 

For outgoing calls it is not enough to add a “sip server” user. You must also add this server(s) in your routing. 
Open the “Routing” form. In the left side you have to define your pattern which will restrict the condition when the actual route 
entries can be used. If all fields are empty and the time definition is set to “All times” then all patterns will match. You can make 
restriction if you make specification here (caller, called prefix, time restriction, etc) . Make sure that you increase the priority for the 
pattern (to be higher than the your “general” pattern where you have not made any restrictions) 
On the right side you will have to add one or more sip proxy user. If you set more than one route with equal priority, then you have 
load balancing, LCR or BRS (depending on the brs_lcr global config option); otherwise the traffic will be routed after the 
prioritizations (will flow to the lower priority servers only if you have reached the maximum port limitations or because automatic 
failowering) 

Register to your outbound server 

Usually for a B2B usage, uppers servers (your carrier or VoIP service provider) will setup IP based authentication. This is the 

favorized method for a high amount of calls. If your outbound server (where you are sending traffic and receive incoming calls) 

needs username/password based digest authentication instead of IP based authentication, you can set it from the “SIP server” user 

configuration. Create a SIP server user, then switch to the “Edit” page. On the bottom of the page you can find a grid named “Proxy 

authentication”. Here you can add the login details (multiple username/passwords can be used for your convenience). Then select 

“Username/password must match” from the “Authorization” drop-down list. 



 

These are the basic and most commonly used authentication settings. There are many other combinations, for example you can forward the 

username/password as received from your users. For more details please consult the Admin Guide. 

 

First test calls 
For a test call create 2 enduser accounts with username/password authentication. 
Register with two softphone and call from the first account to the second account. 
Softphone configuration: 

 domain: your server IP or domain name 
 proxy: you can leave it empty 
 username: the “username” field from the newly created user (tb_users.username) 
 password: the “password” field from the newly created user (tb_users.username) 

 
No any other special settings are required (such as NAT, STUN, etc). 
The network setting should be automatically handled by the server. If you don’t hear any voice you might change the RTP routing for the user(s) to 
“always route RTP”. 

 
During the call, you can open the “Current calls” form in the MizuManage to see the details. 
After the call you can see the CDR by opening the “CDR records” form in the MizuManage. 
If there are no CDR records, it means that the call has not reached the server (wrong network settings on server or client side) 
In case of call failure you can check the disconnect reason from the CDR record or for more details open the last logfile 
(“log_xxx.dat” files near the mserver.exe). 
 

Setup billing 

Open the Billing -> “Price setup” form. 
On the left column add a billing group with any name (default should be ok). 
On the middle column specify your conditions. You should have at least one Enduser cost type without any further restriction on 
the traffic direction (so it will be applied for all your traffic) 
On the right column enter or import your pricelist applied in the conditions defined by the middle column. 
For a default price enter prefix “*” (this will be applied to all destinations) 
Make sure you have set the proper currency (in the global configuration, in the price setup and also for your users) 
Read the Billing guide for more details. 

Monitoring 

List the active sessions: Monitoring -> “Current Calls” form 
Call detail record: Monitoring -> CDR Records form 
Statistics by users: Monitoring ->Advanced Statistics -> Group By: caller 
Statistics by day: Monitoring ->Advanced Statistics -> Group By: day 
 
Other more advanced statistics can be generated by using the Advanced Statistics form and using different 
fields/options/grouping/directions. 
 
All statistics can be filtered by the “set direction” form or the “quick filer” edit-box and by a time interval selection. 
Statistics can be exported as csv or html from File menu -> Save as. For other data formats you can use the Export/Import wizard. 
 
Real time monitoring 
Start the MSupervisor application to get notified about errors and malfunctions. (This application should be available in the start 
menu if you have installed the MizuManage) 
 
Automatic reports 
The server can send daily reports for administrators or email/sms alerts on malfunctions. For this you have to setup an “Admin” 



user with a valid email address. Then set the following fields to 1 (after your needs): “sendemailalert”, “senddailyemal”, 
“sendmonthlyemail”, “sendsmsreport”, “sendsmsalert” 
The server will be able to send SMS messages only if an SMS provider is configured (see the Admin Guide) 
 
CDR records 
CDR records can be listed by using the ά/5w ǊŜŎƻǊŘǎ” form. By default only the most important fields are listed (date-time, connect 
time, call duration, etc). You can see more details if you check the “All fields” checkbox.  
To quickly list the CDR records that belongs to a user, open the “Users and devices” form. Find the user record, then right-click on it 
and select “Set Direction”. Than go back to the CDR record form and click on the “Load/Reload” button. 
If you have enabled voice recording for some users, than you can play the recorded audio by filtering for “Recorded Conversation” 
(select the desired record and click on the Play button) 
 

Enduser / reseller / callshop web portals 

To setup a webportal you have these options: 
-use our default portal (installed by default and listening on port 8080) 
The default portal is included in the install package. You can install and start it from the start menu (start enduser web portal) 
You can check it by opening your browser on the server with this URL: http://127.0.0.1:8080  (or using your public server ip or 
domain name). Login with any valid user account. For the customization options login  as an admin user, You can easily embed this 
portal in your main website (using IFrame for example). There are several options to customize the colors to match you design. 
-rewrite our webportal template to match your needs (Our template portal was written in C++. Request source code from 
support@mizu-voip.com) 
-write your own portal and use the http and/or database API. You will find the documentation here. 
 
IVR setup 
You can assign different IVR’s to different access numbers by using the “Campaigns” form. To create a new campaign, just click on 
the + sign and enter a “name” for the new record. The most important configuration for an IVR campaign is the script. Switch to the 
“details” tab to select a “Script”. 
Scripts can be created by using the “IVR” form. The server is shipped with several preconfigured script examples, but you should 
easily add new scripts or modify the existing ones by following the admin guide or the IVR documentation: IVR.pdf   

Service access numbers 

You can setup your calling card or callback business by using access numbers and assigning them to one of the existing or newly 
created IVR’s. You should be able to request DID numbers from your existing VoIP carrier or by contacting other companies e.g. 
www.didx.net. In this case you will have to add it as a Traffic Sender user usually with IP based authentication (fill the AuthIP box 
with the provider IP or domain name) 
After you have terminated with the traffic sender configuration, you can add the access numbers like usual endusers. Type the 
phone number in the “username” field or you can also use the “SIP number” field for the same reason. Then switch to the 
“Functions” tab and set the “Campaign ID” and the “Callback access” (if the DID number will be used as a callback access number); 
optionally you can enable A number authentication. The campaign id means the ID field from the tb_ccampaigns table (You can see 
them by opening the “Campaigns” form).  
For more complex authentication and billing options please consult the admin guide. 

SMS 

To setup an outbound sms routing, you have to contact a company providing SMS services. (For example Clickatel) 
Then open the “Configurations” form and search for “smsurl”. Enter the details in this format: 
http://api.clickatell.com/http/sendmsg?api_id=APID&user=USERNAME&password=PASSWORD&to=[tonum]&text=[message] 
Pricing is done after the “smsprice” global config options or you can setup detailed pricing by using the “price setup” form. 
Users will be able to send sms messages by using a softphone, the webportal or there is a possibility to create an SMS sender 
application yourself by using the http or database api.  
For incoming SMS applications (SMS callback, balance request, etc) you will have to request a two way SMS service (to get a DID 
number) 

mailto:support@mizu-voip.com
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Softphone, webphone and mobile client 

We provide customized softphone, webphone and mobile client applications for our customer as part of the “all in one package”. 

Backup 

All data is stored in the database, so you have to make sure that you always have a working backup for it.  A nightly backup to some 
other PC on the LAN is an affordable solution for this (depending on your business requirements). 
You can setup scheduled backup or (nearly) real time log shipping from SQL Server Management Studio or alternatively the Mizu 
Server can schedule your backups (see the detailed documentation). 
Optionally you can use a dual server setup. This will increase the performance and in this way, you can always have a hot backup 
server in case if the active server fails. 
 
To clone a VOIP server, just backup its database and restore it on your new server. Also install the VoIP server software (or copy the 
old directory) and make sure that your vserver.ini points to the new database. 
The only setting that must be changed is the local IP global config option. For more details check the cloning guide. 
If you migrate the application to another server a new license file might be needed from Mizutech. 

More help 
For more details, please consult the Admin Guide and other server related documentations on our website. 
For more help, contact support@mizu-voip.com. We offer free install, configuration, training and support services for our 
customers. 
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